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PredictAssist has two basic functions; one is to record your predictions for each game of the season, and the 

other is to help you make your predictions by providing both historical performance data and a copyrighted 

algorithm that uses performance data to generate a prediction for you.  This is not intended as gambling 

software and the author makes no guarantees regarding the predictions made by the “PC” feature of this 

software.  It is strongly recommended that the user read the license agreement in the appendix of this manual 

prior to use. 

 

PredictAssist Features: 

 

• track picks for up to 100 users 

• download team scores 

• download season schedule 

• edit team names or their division membership 

• edit user names, passwords, and status 

• show team season performance data and schedule 

• display season schedule and pick data by team, week, or in its entirety 

• display user pick statistics and past year results 

• set your own display color scheme based on any team’s colors 

• generate game predictions algorithmically with point spread 

• export user and season statistics to CSV files 

• backup user pick data to separate files 

 

 

Login screen: Both the User Name and Password are case sensitive.  Please do not use “.” or “,” within either. 
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Use the Forgot Password link to view the hint you set for yourself.  You must enter your user name first.  The 

hint is set using the “Change Password” option under the File drop-down menu. 

 

Main screen with season schedule showing game results and all user picks: 

 

 
 

 

File Menu: 
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Enter Game Scores: Manually enter game score results by week. 

 

 
 

Download Game Scores: Download game scores using internet connection. 
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Manage Teams: Add teams, delete teams, and edit team characteristics including division and name. 

 

 
 

User List Administration: Add players, delete players, change the admin user, and manage player status, 

password, and user name.  Move active players up and down in list to change the order they appear in the All-

User Pick Results table. 
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Change Password: Change your user password and password hint.  If you change the hint, please remember to 

fill-in the password fields also or the password will be erased. 

 

 
 

 

Reset System Files: Restores important system files including the database that contains game schedule and 

scores.  To backup and restore pick data and admin settings, see the “Backup” and “Restore” File menu options. 

 

Change Browser: Choose the browser that activates when you select the “View Injury Report” and “View 

Scores” selections under the View menu strip item. 
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Color Settings: You can change the window background and text color combination to match any of the NFL 

team colors. 
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Export – All-User Pick Results: Produce a CSV file in your PredictAssist folder located in My Documents 

that replicates the main screen table showing all user picks and scores for each game of the season. 

 

Export – Active User Stats: Produce a CSV file in your PredictAssist folder located in My Documents that 

shows each player’s pick record for the season. 

 

Export – Current Season Schedule: Produce a CSV file in your PredictAssist folder located in My Documents 

that contains just the current season schedule. 

 

 

 
 

Backup – Picks Data: Make duplicate backup files of all players’ pick data files.  This is used with the Restore 

function to retrieve player data files in case the active files are lost or damaged.  These files have a .bak 

extension and can be manually copied by the user to other secure locations. 

 

Backup – Admin Data: Make duplicate backup files of the admin setting files.  This is used with the Restore 

function to retrieve admin data files in case the active files are lost or damaged. 
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Restore – Picks Data: Retrieve the duplicate backup files of all players’ pick data files.  This is used with the 

Backup function to make duplicate player data files in case the active files are lost or damaged.  These files 

have a .bak extension and can be manually copied by the user from other secure locations. 

 

Restore – Admin Data: Retrieve duplicate backup files of the admin setting files.  This is used with the Backup 

function to make duplicate admin data files in case the active files are lost or damaged. 

 

 

Log out of Session: End your session but do not end program.  The login screen appears after log out is 

complete. 

 

View Menu: 
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Season Calendar: Show the season schedule with a calendar month format. 

 

 
 

All-User Pick Results – All Week View: View the full season with all weeks, games, and teams. 

 

 
 

All-User Pick Results – Single Week View: Choose an individual game week in the schedule using the drop-

down menu. 

 

All-User Pick Results – Team View: View all weeks for an individual team using the drop-down menu. 

 

User Statistics: View each user’s pick history and success percentages for the current and past seasons. 

 

Team Statistics: View each team’s season record and match-ups remaining in the season.  Also view the PC’s 

team ranking generated from statistical data. 

 

Check Injury Report on NFL.com: Open the NFL.com injury report website using a separate web browser. 

 

Check Scores on NFL.com: Open the NFL.com active score website using a separate web browser. 

 

Note: The web browser that activates to show these features may be changed using the “Change Browser” 

utility under the File menu strip item. 
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Help Menu: 

 

 

 
 

 

User Manual: Activate and view the manual PDF file for this software. 

 

License Agreement: View the license agreement to use this software. 

 

About PredictAssist: View the version and copyright information for this software. 
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Other Notes: 
 

 
 

Click on a pick cell in the main table shown above to enter or edit the desired team pick in the user’s column.   

 

A correct pick in a player’s column is shown in green.  An incorrect pick is shown in red.  A no pick is shown 

with a blank white cell in the table. 

 

The winning team is highlighted with green text under the Visitor or Home Team columns. 

 

‘PC’ is the auto-generated pick list compiled by the software.  No other user may have the ‘PC’ user name. 

 

Hover your mouse over a PC pick to see a ‘spread’ that the pick is predicted to win by over the opposing team.  

The bigger the spread, the greater the statistical confidence the PC has in its pick. 
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In the Team Statistics window, click on a team in the Teams Beaten or Teams Lost To list boxes to view more 

detail about that matchup. 

 

‘Trend’ in the Teams Statistics window is how many of the immediately previous games the team has won. 

 

The ‘PC Ranking’ list sorts the teams using an algorithm to determine strength based on past performance.  The 

strongest performer is at the top of the list, the weakest at the bottom. 
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Team Abbreviation Codes: 

 

AZ Arizona Cardinals 

ATL Atlanta Falcons 

BAL Baltimore Ravens 

BUF Buffalo Bills 

CAR Carolina Panthers 

CHI Chicago Bears 

CIN Cincinnati Bengals 

CLE Cleveland Browns 

DAL Dallas Cowboys 

DEN Denver Broncos 

DET  Detroit Lions 

GB Green Bay Packers 

HOU Houston Texans 

IND Indianapolis Colts 

JAC Jacksonville Jaguars 

KC Kansas City Chiefs 

LAS Las Vegas Raiders 

LAC Los Angeles Chargers 

LAR Los Angeles Rams 

MIA Miami Dolphins 

MIN Minnesota Vikings 

NE New England Patriots 

NO New Orleans Saints 

NYG New York Giants 

NYJ New York Jets 

PHI Philadelphia Eagles 

PIT Pittsburgh Steelers 

SF San Francisco 49ers 

SEA Seattle Seahawks 

TB Tampa Bay Buccaneers 

TEN Tennessee Titans 

WAS Washington Commanders 
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License Agreement 
 

From The PredictAssist Author  

software LICENSE AGREEMENT FOR PredictAssist FOR WINDOWS 

 

PLEASE READ THIS software LICENSE AGREEMENT ("LICENSE") CAREFULLY BEFORE USING 

PredictAssist software.  BY USING PredictAssist, YOU ARE AGREEING TO BE BOUND BY THE TERMS 

OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, DO NOT USE THE 

software.  

 

1. General. The PredictAssist software, documentation and any fonts accompanying this License whether on 

disk, in read only memory, on any other media or in any other form (collectively the PredictAssist ") are 

licensed, not sold, to you by PredictAssist Author for use only under the terms of this License, and PredictAssist 

Author reserves all rights not expressly granted to you. The terms of this License will govern any software 

upgrades provided by PredictAssist Author that replace and/or supplement the original PredictAssist Author 

product, unless such upgrade is accompanied by a separate license in which case the terms of that license will 

govern.   

 

Title and intellectual property rights in and to any content displayed by or accessed through the PredictAssist 

software belongs to the respective content owner. Such content may be protected by copyright or other 

intellectual property laws and treaties, and may be subject to terms of use of the third party providing such 

content. This License does not grant you any rights to use such content. 

 

2. Permitted License Uses and Restrictions.  

A. Subject to the terms and conditions of this License, you are granted a limited non-exclusive license to install 

and use the PredictAssist software. You may not make the PredictAssist software available over a network 

where it could be used by multiple computers at the same time. You may make one copy of the PredictAssist 

software in machine-readable form for backup purposes only; provided that the backup copy must include all 

copyright or other proprietary notices contained on the original.  

 

B. You may not and you agree not to, or to enable others to, copy except as expressly permitted by this 

License), decompile, reverse engineer, disassemble, attempt to derive the source code of, decrypt, modify, 

create derivative works of the PredictAssist software, or any part thereof (except as and only to the extent any 

foregoing restriction is prohibited by applicable law).  Any attempt to do so is a violation of the rights of 

PredictAssist Author and its licensors of the PredictAssist software. 

 

3. Transfer. You may not rent, lease, lend, redistribute or sublicense the PredictAssist software. You may, 

however, make a one-time permanent transfer of all of your license rights to the PredictAssist software to 

another party, provided that: (a) the transfer must include all of the PredictAssist software, including all its 

component parts, original media, printed materials and this License; (b) you do not retain any copies of the 

PredictAssist software, full or partial, including copies stored on a computer or other storage device; and (c) the 

party receiving the PredictAssist software reads and agrees to accept the terms and conditions of this License.  

 

4. Termination. This License is effective until terminated. Your rights under this License will terminate 

automatically without notice from PredictAssist Author if you fail to comply with any term(s) of this License. 

Upon the termination of this License, you shall cease all use of the PredictAssist software and destroy all 

copies, full or partial, of the PredictAssist software. 
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5. Limited Warranty on Media. PredictAssist Author warrants the media on which the PredictAssist software is 

recorded and delivered by PredictAssist Author, if applicable, to be free from defects in materials and 

workmanship under normal use for a period of ninety (90) days from the date of original retail purchase. Your 

exclusive remedy under this Section shall be, at PredictAssist Author's option, a refund of the purchase price of 

the product containing the PredictAssist software or replacement of the PredictAssist software which is returned 

to PredictAssist Author or an PredictAssist Author authorized representative with a copy of the receipt. THIS 

LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUDING, BUT NOT 

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY 

QUALITY, AND OF FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO 

NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS 

DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE 

LIMITATION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE 

ONLY WARRANTY MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF 

ANY) CREATED BY ANY DOCUMENTATION OR PACKAGING. THIS LIMITED WARRANTY GIVES 

YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY BY 

JURISDICTION. 

 

6. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE 

PredictAssist software (AS DEFINED ABOVE) AND SERVICES (AS DEFINED BELOW) IS AT YOUR 

SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE, 

ACCURACY AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED WARRANTY ON MEDIA SET 

FORTH ABOVE AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE 

PredictAssist software AND SERVICES ARE PROVIDED "AS IS", WITH ALL FAULTS AND WITHOUT 

WARRANTY OF ANY KIND, AND PredictAssist Author AND PredictAssist Author'S LICENSORS 

(COLLECTIVELY REFERRED TO AS "PredictAssist Author" FOR THE PURPOSES OF SECTIONS 6 

AND 7) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS WITH RESPECT TO THE 

PredictAssist software AND SERVICES, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, 

BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF 

MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, 

OF ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. 

PredictAssist Author DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF 

THE PredictAssist software OR SERVICES, THAT THE FUNCTIONS CONTAINED IN THE PredictAssist 

software OR SERVICES WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE 

PredictAssist software OR SERVICES WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 

DEFECTS IN THE PredictAssist software OR SERVICES WILL BE CORRECTED. YOU FURTHER 

ACKNOWLEDGE THAT THE PredictAssist software IS NOT INTENDED OR SUITABLE FOR USE IN 

SITUATIONS OR ENVIRONMENTS WHERE THE FAILURE OF, OR ERRORS OR INACCURACIES IN 

THE CONTENT, DATA OR INFORMATION PROVIDED BY, THE PredictAssist software COULD LEAD 

TO DEATH, PERSONAL INJURY, MONETARY LOSS, OR SEVERE PHYSICAL OR ENVIRONMENTAL 

DAMAGE, INCLUDING WITHOUT LIMITATION THE OPERATION OF NUCLEAR FACILITIES, 

AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL, LIFE 

SUPPORT OR WEAPONS SYSTEMS. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 

BY PredictAssist Author OR AN PredictAssist Author AUTHORIZED REPRESENTATIVE SHALL 

CREATE A WARRANTY. SHOULD THE PredictAssist software OR SERVICES PROVE DEFECTIVE, 

YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR 
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LIMITATIONS ON APPLICABLE STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE 

EXCLUSION AND LIMITATIONS MAY NOT APPLY TO YOU.   

 

7. Limitation of Liability. THE USER AGREES THAT IN NO EVENT SHALL PredictAssist Author BE 

LIABLE FOR PERSONAL INJURY, MONETARY LOSS, OR ANY INCIDENTAL, SPECIAL, INDIRECT 

OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, 

DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER 

COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR 

INABILITY TO USE THE PredictAssist software OR SERVICES, HOWEVER CAUSED, REGARDLESS 

OF THE THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF PredictAssist 

Author HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO 

NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL OR 

CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU.  

7a. IF THIS SOFTWARE IS USED IN CONJUNCTION WITH ANY FORM OF PRIVATE OR 

COMMERCIAL WAGERING OR GAMBLING, THE USER AGREES THAT IN NO EVENT SHALL THE 

PredictAssist Author BE LIABLE FOR MONETARY LOSS OR PERSONAL INJURY RESULTING FROM 

INCORRECT PREDICTIONS OR FORECASTS FROM USE OF THIS SOFTWARE. 

 

8. Export Control. You may not use or otherwise export or reexport the PredictAssist software except as 

authorized by United States law and the laws of the jurisdiction in which the PredictAssist software was 

obtained. In particular, but without limitation, the PredictAssist software may not be exported or re-exported (a) 

into any U.S. embargoed countries or (b) to anyone on the U.S. Treasury Department's list of Specially 

Designated Nationals or the U.S. Department of Commerce Denied Person’s List or Entity List. By using the 

PredictAssist software, you represent and warrant that you are not located in any such country or on any such 

list. You also agree that you will not use these products for any purposes prohibited by United States law, 

including, without limitation, the development, design, manufacture or production of missiles, or nuclear, 

chemical or biological weapons. 

 

9. Government End Users. The PredictAssist software and related documentation are "Commercial Items", as 

that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer software" and "Commercial 

Computer software Documentation", as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, as 

applicable.  Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §227.7202-1 through 227.7202-4, as applicable, the 

Commercial Computer software and Commercial Computer software Documentation are being licensed to U.S. 

Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other 

end users pursuant to the terms and conditions herein. Unpublished-rights reserved under the copyright laws of 

the United States. 

 

10. Controlling Law and Severability. This License will be governed by and construed in accordance with the 

laws of the State of Washington, as applied to agreements entered into and to be performed entirely within 

Washington between Washington residents. This License shall not be governed by the United Nations 

Convention on Contracts for the International Sale of Goods, the application of which is expressly excluded. If 

for any reason a court of competent jurisdiction finds any provision, or portion thereof, to be unenforceable, the 

remainder of this License shall continue in full force and effect.   

 

11. Complete Agreement; Governing Language. This License constitutes the entire agreement between the 

parties with respect to the use of the PredictAssist software licensed hereunder and supersedes all prior or 

contemporaneous understandings regarding such subject matter, with the exception of any additional terms and 

conditions you are required to accept if you choose to use PredictAssist Author's online store which will govern 
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your use of such store and any Services you purchase through that store. No amendment to or modification of 

this License will be binding unless in writing and signed by PredictAssist Author. Any translation of this 

License is done for local requirements and in the event of a dispute between the English and any non-English 

versions, the English version of this License shall govern. 

 

12. Third Party Acknowledgements and Terms. Portions of the PredictAssist software utilize or include third 

party names and trademarks and other copyrighted material. Your use of such material is governed by their 

respective terms.  

 

13. Miscellaneous Provisions. These TOS will be governed by and construed in accordance with the laws of the 

State of Washington, without giving effect to its conflict of laws provisions or your actual state or country of 

residence. If for any reason a court of competent jurisdiction finds any provision or portion of the TOS to be 

unenforceable, the remainder of the TOS will continue in full force and effect.  

 

These TOS constitute the entire agreement between the parties with respect to the subject matter hereof and 

supersedes and replaces all prior or contemporaneous understandings or agreements, written or oral, regarding 

such subject matter. Any waiver of any provision of the TOS will be effective only if in writing and signed by 

PredictAssist Author.  

 

14. No logos, symbols, or trademarks of the National Football League (NFL) or its individual teams are used by 

this program.  All rights are reserved for the NFL and its constituents regarding the usage of team names.  

PredictAssist Author is not contracted or endorsed by the NFL or any of its constituents.  PredictAssist does not 

endorse the NFL or any of its constituents but is intended for the sole use and entertainment by the end user. 

             

Rev. 5/29/2023 

 


